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Versions

Publication Date Version

1.0 18 Dec 2024 First issue

2.0 10 Apr 2025 Major updates by section:

e Section 2 Data Catalog: Added Section 2.1 Data

product page.
e Section 2.2 New user registration: Updated with

new registration process.

e Section 2.3 Signing in and signing out: Added

additional information on menus.

e Section 2.4.2.1 Checkout — Address: Revised to
pre-populated user registration information.

e Section 2.4.2.3 Checkout — Delivery: Updated
Delivery Destination setup options.

e Section 3 Settings: Added 3.2 User Settings.

e Section 4 My Account: Added data download

information under 4.3 My Data; added 4.4 My
Subscriptions.
¢ Updated screenshots with the latest Data

Marketplace interface across all sections.

3.0 1 Dec 2025 Major updates by section:

¢ Terms and Conditions acceptance: Changed from
registration-based to order-based. Corresponding

instructions were added under 2.4.2 Checkout.

e Section 2.3 Signing in and signing out: Added

remarks for password requirements and account

lockout policies.

e Section 2.4.2 Checkout: Updated checkout process
upon the introduction of more payment options.
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Updated screenshots and navigation instruction
with the latest Data Marketplace interface across all

sections.
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DISCLAIMER

HKEX and/or its subsidiaries have endeavoured to ensure the accuracy and reliability of the
information provided in this document, but do not guarantee its accuracy and reliability and accept
no liability (whether in tort or contract or otherwise) for any loss or damage arising from any
inaccuracy or omission or from any decision, action or non-action based on or in reliance upon
information contained in this document.
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1 Overview

HKEX Data Marketplace is a web-based platform that will give all clients direct access to HKEX'’s
historical data products. This user guide is written to enable users to make full and efficient use of
the HKEX Data Marketplace, it aims to provide guidance on the Data Catalog, Account Management,
Check Out and Data Download process.

2 Data Catalog

The Data Catalog is the default landing page for Data Marketplace. This screen allows users to
browse the data products available in the data catalog and sign in to access the full functionalities.

— Filter Data Product Search by text
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Users can use the search box to find data products which are related to the term they are searching
for and/or filter the products which match their requirements using the navigation panel on the left.

Click on a data product and view detailed information about that data product.

2.1 Data product page

The data product page provides the Product Overview, Description, Technical Details, Usage
Terms and Licensing Options of a data product. It also allows user to access the Download feature
for licensed data product.
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HKEX N I® 1 ®E @ B IERBELU

LE B2 1

Historical Full Book - Securities Market (CSV Format)

Daily tie proviges information on every order and trade recorded on the HKEX's Main Board and GEM Assot Classes Equities, ETPs, REITs, Warrants, CB8Cs, Dabt Socurities
stocks in CSV format

Category HKEX Securities Market

Licensing Options > Coverage HKEX Main Board, HKEX GEM

Data Typo Trados, Orders

Date Range 03/01/2022 -01/12/2025

Delivery Time normally at around 10:00 p.m HKT (UTC+0800)on T

tssue Basis Daily
Format v
Dataset Code CFBC
Last Updated 01122025
Delivory Method 4 =

Description

Data contents:

Stock code, order information (acd order, modily order and delete order) and trace INFONMATion (LransacTion time, traded pACe and QuUantity, etc. of new trade and trade cancellation).

Stock coverage:

All stocks radable on the Main Board and GEM including ordinary and preference shares, equity warrants and derivatives warrants, etc

For adamional technical iInformation and product history, please contact us

2.1.1 Licensing Options

Click the Licensing Options button at the top of the page to navigate to the license options section.

Select license option:

Historical Data HKD 200,000.00 Subscription-3 Months HKD 15,000.00 Subscription- 6 Months HKD 30,000.00

Jan 2022 ) Apr2025 ™ 01 Apr 2025 - 01 Apr 2025 -
Add to cart HKD 5,000 00/month HKD 5,000 00/maonth HKD 5,000.00/month

Subscription - Annual (15% discount) HKD 51,000.00

01 Apr 2025 -

Add to cart HKD 4,250.00/month

The license options allow users to license different ranges of historical data products or subscribe
to data products on an on-going basis for different periods of time.

The following license options are available:
Historical Data

o Pre-selected period — this allows the users to access a pre-selected historical date range
of data product.
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o Flexible period — this allows the users to flexibly specify the historical date range of data
product.

Subscriptions

o Pre-selected period — this is a subscription for a pre-selected period such as 3 months, 6
months or annually. The data product subscriber is charged for the full amount at the
beginning of the subscription period. User can select the subscription to commence from the
current month, next month or the month after next.

Note: If users are interested to purchase data for the current month or a specific period not listed
under the licensing options, please contact us at datamarketplace@hkex.com.hk.

2.1.2 Downloading Data

Data product which signed-in users have licensed will display a Licensed flag on the product page
and the Download button will also be available:

CCASS Shareholding Data

The CCASS Shareholding Data provides daily records of Participants’ holdings in CCASS Eligible
Securities listed on the Stock Exchange of Hong Kong. The data reflects the shareholdings after the

securities are cleared and settled by HKSCC.
) Licensed

| Licensing Options = l l Download =

For detailed information on the Download function, please refer to the guide provided for Download
Data pop up under Section 4.3 My Data.

2.2 New user registration

To create a new user account click Sign In on the top right menu and then click on the Create an
account link in the sign in screen.


mailto:datamarketplace@hkex.com.hk
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Sign in to your account

Email
o
=3
Password

&

[ ] Remember me

ace?|Create an account

User will be taken to the account creation page to enter user details, provide account type information,
and Data and Marketing Preferences.

Already have an account? Log in
Create your account £

Step 1: Enter your details

Full name*

Password*

Your password must include:

© 2 minimum of 8 characters

© atleast 1 number

@ atleast 1special character (e.q. # * &)
o at least 1 uppercase letter

© atleast 1 lowercase letter
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Step 2: Select account type: Business, Academic or Personal and complete the form

Account Type* Business @ Academic ()

Company Name*

Address 1%

Address 2

State / Province

Country* Postcode

Data and Marketing Preferences
[] !do notwish to receive information about HKEX's and its affiliates’ financial services and information services.

[ !do notwish to undertake any transfer of my name and contact details to your affiliates for the purposes of receiving
information from them about their financial services and information services.

By dicking 'Create an account’, | consent to the processing of my personal data in according with the Privacy Policy Statement

Once user has provided registration details and clicked the Create an account button, an email with
a verification link (valid for 1 day) will be sent to the registered email. If the link is expired, user will
need to Sign in again to trigger another verification link.

Clicking the verification link will complete the email verification process and take the user back to
the site.

Note: Users who have registered prior to 10 Apr 2025 will be prompted to update additional

information which was not available in previous Data Marketplace version upon next login, including
Account Type, address information, as well as Data and Marketing Preferences.

2.3 Signing in and signing out

Go to the site and click the Sign In button on the top account menu bar.
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e aixin o v (I
) Q Name Ascending w B =

Seanch globalty instead

HKEX Data
Categories

Enter email and password and click Sign in.

HKE X

EEBXEF

Sign in to your account

Email

o

=
Password

o]

[_] Remember me

Marketplace? Create an account

If the signing in is successful, the Data Catalog page will be displayed.

If incorrect credentials were entered, user will be prompted to try again. After five consecutive
incorrect login attempts, the account will be locked for 30 minutes. The lockout period will increase
by 30 minutes for every five incorrect login attempts. Please contact the Data Marketplace Helpdesk
at datamarketplace@hkex.com.hk for any issues.

To reset password, click on the “Forgot Password?’ link below the Sign in button and follow the
instructions. The new password must differ from the previous five passwords.

Signed-in users will see the following menus in the top menu bar:

¢ Help — provides contact details for Product Queries and Technical Support.

e Settings — access Data Delivery Destinations and User Settings.

10
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o Data Delivery Destinations: select Default Delivery Destinations, add and
manage delivery destinations

o User Settings: adjust the maximum size of an extract file for data request and turn
on/off subscription email notification

Please refer to Section 3 Settings for further information.

o My Account — access account related information including My Profile, Order History, My
Data, My Subscriptions, as well as the ability to Log Out of your account.

o My Profile: view registered account details.
o Order History: view the history of orders placed.
o My Data: view and access the data products user has been licensed with.

o My Subscriptions: view subscriptions and configure Delivery Destination for each
subscription.

Please refer to Section 4 My Account for detailed information.

e My Cart — view any items in your shopping cart.
To return to the home page, click HKEX Logo on the top navigation menu bar.

To exit the session, click My Account on the top menu and then click Log out from the dropdown
menu.

HKEX

EN | ¥ | @ b=
ge=EEn @ @ by Q
My Profile >
Q Name View your profile
Search globally instead Order History 2>
View orders
HKEX Data
Categories My Data 2
View your datasets
HKEX Data s Bid and Ask Record - All Futures/Options (Daily Bid and Ask R
HKEX Securities Market File) Futures/Optic My Subscriptions 2
e View your subscriptions
HKEX Derivatives Market HKEX Derivatives Market HKEX Derivat
Stock Connect Daily file provides intra-day best bid and ask information Daily file provid} Log Out =3
on all standard futures and options traded on HKEX's on all standard
Derivatives Market. on HKEX's Derive
Filters I Read More > Read More >

2.4 Cart & Checkout

The cart and checkout process allow users to select and submit an order for data products from Data
Catalog. The checkout allows the user to provide their details and specify payment and delivery
options.

11
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2.4.1 Shopping Cart

2411 Adding items to your cart

To add an Item to the cart, go to the data product and navigate to the licensing options section,
select the data product you would like to purchase and click Add to cart. Added product will show

as Added.

Select license option:

Historical Data HKD 200,000.00 Subscription - 3 Months

Jan 2022 ()

Apr 2025 [ 01 Apr 2025 -

@ Added

HKD 5,000.00fmonth HKD 5,000.00/month

Subscription- Annual (15%
discount)

HKD 51,000.00

01 Apr 2025 -

HKD 4,250.00fmonth

2.41.2 Viewing your cart

HKD 15,000.00

Subscription - 6 Months

01 Apr 2025

HKD 30,000.00

-

HKD 5,000.00/month

To view the contents of the shopping cart, click on the My Cart button in the top menu.

HKEX

& EERN

EN | I @

@ &

P 0

User will be taken to the cart page which will show all the items in the cart. User may remove items
by clicking on the delete icon and empty the cart by clicking Clear Cart. Click on the Secure
Checkout to start the checkout process. User will be redirected to Sign In page if not yet signed in.

If a promo code is available, enter the code in My Cart. Promo codes cannot be applied once

checkout begins.

12
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My Cart 2 Items
Cart Summary
CCASS Shareholding Data > HKE> Market Ty
Subscription ’ ’ Subscription ~ HKD 180,000.00
> HKD 180,000.00
CCASS Shareholding Data
Historical Full Book - Securities Market 3 X Securities [E] 3 Subscripion-Anmual  HKD 180,000.00
(CSV Format) N » Starts on01 Dec 2025
i > N HKD 10,000.00
Historical ~ HKD 10,000.00
< Return to Data Catalog % Clear Cart

Historical Full Book - Securities
Market (CSV Format)

» Historical Data HKD 10,000.00
» Ot 2025-Mowv 2025

Total HKD 190,000.00

Accepted Payments

-
s BB 7~

() Secure Checkout |

2.4.2 Checkout

The checkout is a 4-step process:

1. Account Details
2. Payment Method
3. Order Status

4. Delivery

2.4.2.1 Checkout — Account Details

The address screen will pre-populate user’s registered account type and address information.

13
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» »

Step 1 Account Details

Checkout | Account Details

® Cart Summary

Subscription ~ HKD 180,000.00

Full Name *
CCASS Shareholding Data

3 Submcription - Arnsl HEKD 180,000.00
3 Starison 0 Dec 2025

Company Name * Historical ~ HKD 10,000.00
Historical Full Book - Securities Market (CSV Format)

* Historical Data HKD 10,000.00
2 Oct 2005 - Nov 2020

Address Line 1%
Total HKD 190,000.00

Address Line 2 Accepted Payments

s WE S

& Proceed to Payment
City* Country*

StatefProvince Postoode

View and confirm the Cart Summary, click Continue to proceed to the payment.
2.4.2.2 Checkout — Payment Method

Currently, four types of payment methods are available. Some options may appear greyed out if not
supported for the specific transaction, for example, when the order amount exceeds the allowed
transaction limit.

e Bank Transfer

e Credit Card

¢ HKFPS QR Code
e PayPal

User must accept the Terms and Conditions to proceed.

14
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¥ ¥ L ot
Step 1 Account Detals Step 2 Payment Mothod Step 3 Order Status Step 4 Dalivery
Checkout | Payment Method
Please select a payment method:
Cart Summary
4
©  BankTransfer A Subscription HKD 180,000.00
Historical + HKD 10,000.00

() Credit Card Total HKD 190,000.00
‘ ) Piace Order
O PayPal PayPal

For Visa or Mastercard, payment is available via PayPal.

Tha groyod-out paymant methods e not supported for this transaction. Please solact an allomMative payment method 1o
procoed,

+ Go back to Account Details

.H KE x datamarketpla

BxERE

Terms and Conditions
‘We, the subscriber, understand that by subscribing to HKEX Data Products, we agree to be bound by the terms and conditions set out below.

1. HKEX DATA PRODUCTS
HKEX Data Products comprises all historical data products and reference data available for subscription from HKEX Information Services

Limited ("HKEX-157) in digital form as listed from time to time on the Historical Data section of Hong Kong Exchanges and Clearing Limited’s
("HKEX") website.
2. PROPRIETARY INTEREST

‘We understand and acknowledge that we have no entitlement to any proprietary rights including without limitation rights of copyright in
the subscribed data products (including third party content, if any), which rights are owned by or licensad to HKEXAS fthe relevant company

within HKEX group or owned by the third party content providers, as the case may be.

3. REDISTRIBUTION PROHIBITED
‘We shall not, in whatever form, reproduce, distribute, retransmit or dissermninate, or otherwise permit any parties to reproduce, distribute,

retransmit or disseminate all or any part of HKEX Data Products.

4. SERVICE DISCONTINUANCE OR MODIFICATION
HKEX-IS may, with or without notice to us, (1) discontinue its provision of all or any HKEX Data Products; (2) modify the means or format by

which it provides HKEX Data Products; and (3) change or eliminate information contained in HKEX Data Products; whether or not any such
discontinuance, modification, change or elimination would require us to make any changes in our equipment or would adversely affect our
business. In case of discontinuation by HIKEX-IS, we understand that HKEXAS will refund te us any prepaid amounts in respect of undelivered

compact diskettes.
5. DATANOT GUARANTEED

HKEX-IS, its holding companies and/or any subsidiaries of such holding companies do not guarantee the timeliness, accuracy or
completenass of the information provided in HKEX Data Products and accept no liability (whether in tort or contract or otherwise) for any

loss or damage arising from any delay, inaccuracies or omissions.

6. CHANGES TO THE TERMS AND CONDITIONS
HKEX-IS reserves the right to make changeas to the terms and conditions at any time.

Decline

15
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Click Place Order to submit the order.

Stop 1 Step 2 Payment Mathod

Checkout | Payment Method

Please select a payment mathod

-
‘ @  Bank Transfer IM'I:I
]
‘ Credit Card KE ‘
!
‘ PayPal

For Visa or Mastercard, payment is available via PayPal

The greyed-out payment methods are not supported for this transaction. Please select an alternative payment method to

proceed.

2.4.2.3 Checkout — Order Status

Step 4

Cart Summary

Subscription ~ HKD 180,000.00

Historical HED 10.000.00

Total HKD 190,000.00
B | accept the fesms and conditions

Once an order is successfully placed, an order confirmation email will be sent to the registered email
address. Users can also view the order ID and a detailed summary on the Order Status page. If the
user opts for bank transfer, the corresponding instruction will be displayed as well.

Click Continue to proceed.

16
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Step 1A i Dt Step 2 t Met Step 3 Order Status Step 4

Checkout | Order Status

Q Thank you for your onder.
Your Order ID s D2502998

An order confirmation will be Sont 1o your email address shortly.
Ploasa rofor 1o bolow bank transfor dotails to complota your purchase:
Bank Transfer Details

Name of Bank: The Hongkong and Shanghai Banking Corporation Limited
Bank Code 004

Account Numbser: 500-478785-001

Account Name: Hong Kong Exchanges and Clearing Limited

Bank Address: 1 Queen's Road Central, Hong Kang

Swift Code: HSBCHEHHHEH

»  Paymont via direct deposit/bank transfor should be in Hong Kong Dollars, kindly be reminded that all bank charges (including interbank charges) ncurmed must boe Bomme by subscriber, Ploase
settle all bank charges separately with your bank so as to make sure that the exact order amount will be credited to our bank account.

» This order will be processed upon the receipt of full payrment. Ploase make payment with bank remittance returned by email to datamarketplace@hko:.com.hk within 14 working days. Mo
further receipts/demand notes will be issued, please take this Order Confirmation for record.

IF you have any querses on your order, please contact us a1 datamarketplace@hiken com. hi, Please quote the Onder 1D in all your commespondence with us

Your Cart Summary

CCASS Shareholding Data b HE M HED 150.000.00
Sebacrpen + Sareem 1O

Historical Full Book - Securities Market (C5Y Format) » MK H HED 10,000.00
Historical ;

Sub-total HKD 190,000.00

Amount Due HEKD 190,000.00

2.4.2.4 Checkout — Delivery

User will be taken to the Delivery page where the user is able to specify the Delivery Destination
of the order. User can choose to Set Up Later or Submit their delivery preferences to proceed.

User can Configure New Delivery Destination by clicking the Add new delivery destination
button. To configure the delivery destination for each product separately, deselect All datasets in
this order to be delivered to the same destination.

17
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Step 1 Step 2 Step 2 Step 4 Delivery

Checkout | Delivery
To ensure seamless delivery of your data, please complete Step 4 confirm your delivery preforences.

IT youl requine any support of have inguires about your order, please reach out 1o us at datamarketplaceghlex.com.hk.
Please reference your Order ID: D2502998 in all correspondence

Configure New Delivery Destination
IT" yousr desired Dalivery Destination is not availabla in the dropdown, please select "Add new delivery destination’ o configura it

Seotup Delivery Destination for your data products
Choose your delivery destination for your purchased datasets.

All datasets in this order 1o be deliverad to the same destination v -

Subscription

Historical

| Set up laver || |

Note:

e For Subscriptions, if no delivery destination is specified, the data will be sent to the Default
Delivery Destination under Settings - Section 3.1 Data Delivery Destinations.
User can manage delivery destinations per subscription via My Subscriptions under My
Account after the order is fulfilled. Please refer to Section 4.4 My Subscriptions for further
details.

HKEX INIT®EI®E @ ® E

aERERMN

Data Delivery Destinations  User Sottings

Data Delivery Destinations
Seloct your default delivery destination from the Default Delivery Destination
dropdown list. If you want to add more

dostinations, you can do 50 by clicking the ~Add

Delivery Destination™. (® Add Delivery Destination

SFTP File Transfer is also supported. Please refor
to the FAQ page or contact us for further details.

Download link via email -

AWS 53 AWS 53 # Edit W Delete

e For historical data, the data delivery will not be automatically triggered unless a delivery
destination is specified. If the user chooses to Set Up Later, please visit Order History under
My Account to complete the setup.

18
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My Profile My Diata My Subscriptions

Owder 1D Oreler Status Oreler Date Total Actions
D2502998 & Pending Bank Trarser 021272025 HED 190,000.00
Product Catogary Licorss Typa Do Range Delivory Dostination =  Set Delvery Destination

CCASS Sharshobding Data HKEX Securities Market Subscription 0171207025 - 3/11/2026 [destination Mot Set

Hestorical Full Book - Securit
— R— HIKEX Sequrities Market Hitstoical 01/ 1002005 - 30/11/200%5 [hestination Not Set
Market (C5W Format)

3 Settings

The settings screens can be accessed by clicking on Settings in the top right menu.
3.1 Data Delivery Destinations

Data Delivery Destinations include the following features:

HKEX ©os ¥ o

B
"
m

Data Delivery Destinations Usar Sattings

Data Delivery Destinations
Select your default delivery destination from the Default Delivery Destination Dowrioad link via small -

dropdown list. If you want to add more
destinations, you can do so by clicking the "Add

Delivery Destination’ | @ Add Dalivary Destination |
SFTP File Transfer is also supported. Please refer
AWS 53 AwWss3 # Edit [ Delete

1o the FAQ page or contact us for further details.

Default Delivery Destination — user’s primary delivery destination preference for data download
request.

Note: Display on Ul should only be selected for SFTP only users. Please refer to SFTP guide.

Add Delivery Destination - add cloud delivery options, available cloud configuration guide can be
found under Guidance & Reference Materials page.

User added cloud delivery destinations will be shown on the page where user can view, Edit and
Delete each delivery destination.

For SFTP, please refer to SFTP guide under Guidance & Reference Materials page.

19
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3.2 User Settings

To access the user settings, click on Settings in the top bar and then select the User Settings tab.
In this screen user can:

e Specify the maximum size of an extract file: if the data product extraction size requested
is over the maximum file size specified, it will be partitioned into multiple files with each
extract file size lower than the maximum value. Allowed range is 1-20 gigabytes with 20
gigabytes as the default value.

e Subscription email notification: only applicable to cloud delivery. Toggle between On or
Off for receiving email notifications when a subscribed data product is published.

For subscriptions with data delivery destination set to Download link via email, user will
still receive emailed download links even the email notification is toggled Off.

HKEX N % | ® @@ @ B 0

sR=En

Data Detivery Destinations  User Settings

User Settings

Use the usor 5ottings to configuro your

Subscription futflment notification

4 My Account

My Account menu allows user to access account related information including My Profile, Order
History, My Data, My Subscriptions, as well as the ability to Log Out of the account.

4.1 My Profile

My Profile screen displays user’s registered account details. To modify registered account
information, please contact datamarketplace@hkex.com.hk.

20
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My Profile Order History My Data My Subscriptions

My Profile

Full Name

Email Address

4.2 Order History

Order History screen allows user to view the history of orders placed on Data Marketplace including
product, licence Type, date range, purchase date and order status.

HKEX EN

sEREAM

"
5
®
&
uf
=]

My Profile Order History My Data My Subscriptions

Order 1D Order Status Order Date Total Actions
02502911 - ® Complete 1041112025 HKD 32,500.00
D25029/0 - ® Complete 10/11/2025 HKD 180,000.00
D2L02966 - Pending Payment 10/11/2025 HKD B00.00
Displaying 1-3 of 3 results 15 = 1
4.3 My Data

My Data screen allows user to view and access the licensed data products for the date range entitled.

Click the Download button under the Access Data column to initiate a download request.

21
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mI%EI® ® & R O

My Profile Order History My Data My Subscriptions.

Product Category Status Delivery Start Date EndDa  Actions
- Destination ]
{KEX Securities Market ctive AWS 53 01/11/2025 11100
Socurities Attribute Daily Files (C5V Format)  HKEX Securitios Market Esprire] AWS 53 01/11/2025 011 /H = Change Delivery Destination
=

4
Displaying 1- 2 of 2 results

The following pop up will appear under Download Data:

3.

4.

Download Data

You can download up To ong yaar period at a time,

Pro-filled dates default 1o the latest one year poriod of your data entitloment

Mame your download

Select Period * 01/11/2025 ] 02/12/2025 (m)

Set Delivery Destination * Download link via email -

o

Name your download: optional field. Enter a name for this download request, this will
appear on the delivery confirmation email and help user identify what download the delivery
relates to.
Specify the date range for the download using the Start and End Date fields:

o user can download up to one year period at a time. The download request will

return an error if selected period exceeds one year.

o prefilled dates default to the latest one year period of user’s entitlement.
Select the Delivery Destination to be delivered to: User can change the destination by
selecting from the dropdown list.
Click Download to submit the request.

If the download request went through, a pop up will appear on the top of the screen confirming the
request has been submitted.

NI EIE @ & E 0

G/, Download request has been submitted 3
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Requested data will be delivered to the selected destination after the data request is processed.

An alternative way to access the Download function is via the data product page under Data
Catalog. Please refer to Section 2.1.2 Downloading Data for further details.

4.4 My Subscriptions

My Subscriptions screen allows user to view subscriptions and manage the Delivery Destination
of each subscription.

Click Change Destination to select the preferred delivery destination for the subscribed data
product.

HKEX HmWIElE @ @®@ B O

CRERM

« Goto Data Catalex

My Profile Order History My Data My Subscriptions

Product 1 Category Status Delivery Start Date EndDa  Actions
- Destination (o]

CCASS Sharcholding Data HKEX Securities Market (hctive) AWSS3 01/11/2075 10721

Securities Attribute Daily Files (CSV Format)  HKEX Securities Market Expired AWSS3 01/11/2025 ELTLR PPl =»  Change Delivery Destination

4

Displaying 1- 2 of 2 results

To Add new delivery destinations on Settings, click Go to Settings button.

Delivery Destination

Select your delivery destination for this subscription from the dropdown list. To add more

Delivery Destination

Add new delivery destination on Settings

Confirm

Should you have any questions, please contact datamarketplace@hkex.com.hk for assistance.
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